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Abstract
Purpose: This study develops a beginner-oriented roadmap for applying 
PLS-SEM in SmartPLS, addressing the gaps between theory and 
practical application.

Methods: Using an instructional design-based approach, simulated 
datasets with six latent constructs were analysed in SmartPLS 4 to 
demonstrate key steps in measurement validation, structural path testing 
and model evaluation.

Results: The demonstrations shows both acceptable and problematic 
validity outcomes, highlighting how reliability, discriminant validity and 
model fit can be refined. The results are pedagogical, not statistically 
generalizable and shows methodological learning rather than empirical 
findings. 

Conclusion: This study provides novice researchers’ and educators with 
a structured, practice-oriented guide that transforms common PLS-SEM 
pitfalls into learning opportunities, enhancing methodological literacy. 
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I.	 Introduction 
Structural Equation Modeling (SEM) is a cornerstone of social science, business and 
educational research for measuring the complex relationship among the latent constructs. 
Lately, the variance-based approach to SEM-Partial Least Squares SEM (PLS-SEM) has 
gained more attention across various disciplines as a feasible, prediction-oriented alternative 
to traditional covariance-based SEM (Astrachan et al., 2014; Hair & Alamer, 2022). Therefore, 
PLS-SEM measures both the measurement of outer model and the structural linear model 
to maximize explained variance, making the analysis more suited for complex models, 
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developing indicators and non-normal data. As compared to CB-SEM, PLS-SEM often yields 
higher item loadings and composite reliabilities and can deliver solutions with much smaller 
samples by focusing on partial rather than full data analysis (Dash & Paul, 2021). Due to 
these features, PLS-SEM have made an increasingly popular: for instance, Cheah et al. 
(2023) stated that Smart-PLS helped many social science researchers to analyse the complex 
relationships between latent variables and present as a highly popular multivariate data 
analysis method. Despite all these explosive adoptions of SmartPLS and PLS-SEM across 
various multidisciplinary field, beginners still misapply the key steps and under 321 reports 
essential information which creates “theory-practice” gaps. At the same time SmartPLS 4 
introduced features such as HTMT, cIPMA, NCA and others which are powerful: however, 
not beginner friendly. Thus, this requires urgent need of concise roadmap which shows end-
to-end workflow using simulated data, emphasize the correct measurement evaluation and 
translates the common pitfalls for novices’ researchers. Indeed, the release of Smart-PLS 
contributed to the wide-scale adoption of PLS-SEM and different studies utilizes PLS-SEM in 
business, social science and education field. 

Despite of these numerous implementations of PLS-SEM, recent systematic reviews highlight 
common pitfalls in PLS-SEM practice. Such as Ghasemy et al. (2020) stated that many 
higher-education students using PLS-SEM bypass the major key-steps in data screening 
and model evaluation. Dash and Paul (2021) also stated that even though PLS-SEM and 
CB-SEM have better reliability and support, PLS-SEM is still missing some accurate model 
fit statistics. In short, the literature calls for methodological care and clear guidance on PLS-
SEM usage. Whereas, given the sophistication of modern PLS-SEM tools such as SmartPLS 
4’s support for HTMT discriminant validity, multi-group analysis, there is a clear need for up-
to-date, step-by-step roadmap that bridge theory and practice to novice learners. 

Although, PLS-SEM field is rich with domain-specific application and sophisticated 
methodological tutorials but there is relatively less beginner-friendly resources which 
highlights the entire workflow using actual software such as data generation or acquisition, 
model specification, reliability and validity to interpret the outcomes. Sarstedt et al. (2024) 
highlights SmartPLS 4 usage using a pre-built sample; however, they do not show users how 
to get or prepare such data before analysis. Sarstedt et al. explains the use of SmartPLS 
with a ready-made sample dataset; however, they do not guide users on how to obtain or 
prepare such data before starting the analysis. In other words, SmartPLS has enabled many 
researchers to expand their methodological toolbox, beginner often need more relatable 
examples and roadmap as guidance.  While earlier studies have prioritized on connecting 
theory with empirical findings, there is still gap in providing step-by-step guidelines for 
beginners, especially on how to measure construct validity, test reliability and carry out 
model assessment (Hair & Alamer, 2022; Ghasemy et al., 2020; Cheah et al., 2023; Ringle 
et al., 2023). This gap is most apparent in studies that use simulated data for teaching or 
interpreting, as of now only few publications shows the complete roadmap from raw data to 
final PLS-SEM results. 

To address these needs, this study provides a beginner’s fast-map for applied PLS-SEM 
analysis in SmartPLS. Using simulated data sets, this study will walk through each stage 
of PLS-SEM procedure with interpretation and flow chart to access the steps. This paper is 
organized as follows: Section 2 reviews the theoretical and empirical foundation of PLS-SEM, 
section 3 deals with methodology and analytical method, whereas Section 4 and 5 presents 
the SmartPLS result and discussion and conclusion and implication. 
II.	 Reviews
Structural Equation Modeling (SEM) has basically two main routes for beginners to choose 
from which includes Covariance-based SEM (CB-SEM) and Partial Least Squares SEM 
(PLS-SEM). CB-SEM is a factor-based and is utilized when objectives of the research is 
confirming an established theory and report overall model fit and works very well with large 
datasets, normally distributed samples which reflects constructs purely (Hair et al., 2021). 
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Similarly, PLS-SEM is composite-based and aims at prediction as well as explanation of the 
model which tolerate small or non-normal samples and supports formative and reflective 
measures. It is handy for measuring complex models or early-stage theory building (Dijkstra 
& Henseler, 2015; Rigdon, 2016). With PLS-SEM, novice researchers can focus on reliability 
and validity (such as CR, AVE, HTMT) and report SRMR value alongside with R2, effect 
size and prediction checks. A simple rule of thumb can be applied here: Choose CB-SEM to 
confirm mature theories whereas choose PLS-SEM to predict the outcomes and prototype 
models when data or indicators are non-normal or less ideal (Hair et al., 2021). 

Theoretical Foundation
Partial Least Squares Structural Equation Modeling (PLS-SEM) has gained rapid usage 
across various fields for its flexibility in handling complex causal relationships, small sample 
sizes and non-normal data distribution (Sarstedt et al., 2024). It is rooted in the concept 
of composite-based latent variable which spotlight prediction, differentiating it from factor-
based CB-SEM (Joreskog, 1982; Hair et al., 2021). Hidayat and Wulandari (2022) states 
the advantages of SEM which include the ability to build models with different variables, 
measure latent constructs, measure errors in observed variables and perform confirmatory 
factor analysis. SEM is classified into two types: Covariance-based SEM (CB-SEM) and 
Variance-based SEM (VB-SEM), whereas PLS-SEM falls under the VB-SEM. Similarly, CB-
SEM is primarily used for confirming established theories, whereas PLS-SEM prediction and 
estimation with causal explanation in model (Hair et al., 2021). PLS-SEM typically involves 
a structured methodological approach which can be further divided into three stages: data 
screening and diagnostic tests, measurement model assessment and structural model 
assessment (Haji-Othman et al., 2024). PLS-SEM serves both reflective as well as formative 
measurements models, where reflective model indicators are caused by the constructs, 
standard reliability and validity are apply with indicator loadings ≥ 0.70, Cronbach’s alpha and 
composite reliability ≥ 0.70 and AVE ≥ 0.50. Similarly, for formative models, the major shifts 
are to validate the constructs as a combination of unique indicators which requires test for 
multicollinearity and external validity (Dash & Paul, 2021). 

Once the measurement model is specified, PLS-SEM proceeds to Structural model, where the 
major goal is to maximize the predictive accuracy of the targeted constructs. The major outputs 
include path coefficients, R2 value (variance explained), and effect sizes for each predictor. 
Significance of variable is measured through non-parametric bootstrapping by resampling 
data many times, confidence intervals and t-values are obtained without assuming normality 
(Henseler et al., 2009; Marcoulides, 1998). In PLS-SEM to make constructs different from 
each other (discriminant validity) has often been difficult; however, older checks like Fornell-
lacker test (Fornell & Larcker, 1981) and cross-loadings are still used, but the new HTMT ratio 
(Henseler et al., 2016) is now preferred with a cut-off value of about 0.85 or 0.90 (Franke & 
Sarstedt, 2019). Unlike CB-SEM, tests such as CFI or RMSEA do not apply in PLS-SEM. 
Instead measures like SRMR is suggested (Henseler et al., 2016). Still, researchers inform 
that PLS-SEM should focus more on good theory, explanatory and prediction power rather 
than on strict fit measures (Dijkstra & Henseler, 2015; Rigdon, 2016). 

Building theory in PLS-SEM needs clear about the assumptions because its not just 
exploratory. Instead, researcher need to create a conceptual path model based on theories 
or prior research (Sarstedt et al., 2024; Hair & Alamer, 2022). Furthermore, while teaching or 
demonstrating studies using simulated data, constructs and hypothesized paths should be 
priorly define (Rigdon, 2016; Ringle et al., 2023). The Technology Acceptance Model (TAM) 
explains how perceived usefulness and ease of use influence behavioural intentions and 
technology adoption (Davis, 1989; Venkatesh & Davis, 2000). Similarly, Social Cognitive 
Theory (SCT) emphasis on self-efficacy, observational learning and dynamic role of personal 
factors to explain behaviour (Schunk & DiBenedetto, 2019; Bandura, 1986). Whereas, the 
Theory of Planned Behaviour (TPB) states that attitudes, subjective norms and perceived 
behavioural control shape intention and actions (Ajzen, 1991; Fishbein & Ajzen, 2009). 
Together, these theories highlight how PLS-SEM can be used to test theoretical models 
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through the estimation of structural paths, hypothesised paths and validation of constructs. 
Beginner researchers’ can easily and practically understand different workflows with 
SmartPLS, from defining to evaluating paths of latent variable and connects those theories 
to empirical testing. 

Empirical Applications and Gaps

Author and Year Context/
Field Objectives Sample and 

tool Key Findings Limitations/ Gap

(Demir & Uşak, 
2025)

Educational 
Technology

Review PLS-
SEM use

Systematic 
review of 
57 studies, 
SmartPLS

Gaps in 
formative and 
predictive 
reporting

Need demonstration 
with SmartPLS 4

(Nurhidayati et 
al., 2024)

Educational 
behaviour

Validate green 
behaviour 
instrument 

608 students, 
SmartPLS 
for reflective 
measurement 
model using 
SEM

Adequate 
reliability and 
validity support

Did not demonstrate 
and interpret 
structural model 
testing using 
SmartPLS 4. 

(Costa et al., 
2025)

Teacher AI 
adoption

Examine 
AI adoption 
predictors 
among 
teachers

372 secondary 
school 
teachers, 
SmartPLS 4 
PLS-SEM

Significant path 
coefficients, R2 
values

Focused on structural 
model only; minimal 
measurement model 
walkthrough; novice 
may require step-by-
step guidance.

(Elareshi et al., 
2022)

Education/ 
Hybrid 
SEM-ANN 
modeling

Illustrate 
SEM followed 
by neutral 
network 
modeling

n= 180 where 
93% responded 
with PLS-SEM 
+ ANN

PLS-SEM 
effective initial 
modeling; ANN 
adds predictive 
power

Complexity; no 
simplified stepwise 
SmartPLS guide

(Subhaktiyasa, 
2024)

Educational 
Research/ 
Practical 
guide

Proposved 
to analyse 
multivariate in 
PLS-SEM

Literature based 
tutorial using 
SmartPLS

Covers 
reflective, 
formative, 
first/second 
order models, 
measurement 
and structural 
evaluations

Narrative guide 
only, lack concrete 
guidance and 
interpretations

(Nadella et al., 
2024)

Educators 
and Learning 
Management 
System 
(LMS) use

Compare 
PLS-SEM and 
IPMA

237 online 
respondents; 
SmartPLS 4; 
IPMA

Predictors of 
LMS adoption 
identified

Need beginner-level 
roadmap

While Demir and Uşak (2025) conducted a systematic literature review of 57 studies and 
confirmed the widespread use of SmartPLS in PLS-SEM and found underreporting of 
formative model evaluation and predictive relevance metrics. However, Nurhidayati et al. 
(2024) did not measured the structural model because bootstrapped path coefficient, R2 or 
predictive performance were not shown. Instead, they showed a highly reliable instrument 
with strong content validity.  Moreover, similar patterns are observed in other research too: 
for instance (Costa et al., 2025; Nadella et al., 2024) which primarily focus on measurement 
separately, without delivering beginner-friendly, step-by-step workflows that integrate 
measurement Modeling, hypothesis testing and predictive validity. 
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Conceptual Review
Using Technology Acceptance Model (TAM), Social Cognitive Theory (SCT) and Theory of 
Planned Behavior (TPB) together is deliberate and pedagogical, where each theory shows a 
clear mechanism using simulated model allowing beginners to practice mediation, moderation 
and discriminant validity. TAM contributes technology-specific, whereas SCT highlights the 
self-efficacy/confidence as a personal capability belief that mediates and enhance learning 
usage. Similarly, TPB contributes the perceived control along with subjective norms. 
Together, TAM (belief about the system), SCT (beliefs about the self) and TPB (social control 
and intention formation) cover three determinants of system, self and social determinants, 
justifying the usage of all three theories in single training oriented SmartPLS framework. 

Figure 1

Conceptual Framework 

The conceptual framework from Figure 1 links TAM, SCT and TPB theories altogether to 
a pedagogical roadmap of SmartPLS-SEM. By integrating these theories, the framework 
highlights step-by-step guidance to novice researchers to enhance learners’ methodological 
literacy which ultimately helps to improve research skills and outcomes. 
III.	 Methodology
This study adopts instructional design-based methodological approac h, which is used to 
demonstrate how SEM can be effectively, taught through simulation, scaffolding. The major 
goal of this result is not to produce generalizable statistical conclusions instead it aims to 
improve the pedagogical effectiveness and interpretative skills in SEM Modeling. A simulated 
dataset was generated, which includes 6 latent constructs including mediating and moderating 
variables measured by using 4-5 items on a 7-point Likert scale using SmartPLS 4 software. 
This study entirely simulated datasets for instructional purposes. No human participants were 
involved and thus no ethical approval was required. The primary objective of this research 
is to improve statistical literacy and SEM modeling skills among the novice researcher also 
improve the pedagogical efficacy. 
IV.	 Results and Discussion
The Assessment of measurement model from Table 1 highlights that most indicators load 
strongly on their respective constructs with values above the recommended 0.70 threshold 
(Hair et al., 2021). Constructs such as Confidence, Experience, Like and Willingness 
demonstrate good indicator reliability, but Ease of use also perform well though E1 value 
of (0.698) is marginal. Help also has one weak item H1 which lowers its consistency. Peer 
constructs include three strong indicators, however P1 seems to be marginally fit. VIF values 
are generally below 5, indicating no severe multicollinearity issues (Franke & Sarstedt, 2019).
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Step-by-step Guide of SmartPLS 4 

a) Create Project and Import data: Open SmartPLS 4 → File → New Project (Name the 
Project) → Click Import Data →CSV/Excel

b) Build Model: Drag Latent variable from left panel into the Canvas for each LVs → right click 
→ Assign Indicators (Choose items from the datasets) → Draw arrow between constructs 
using connect. 

c) Run PLS-SEM Algorithm: Top Menu → Calculate → PLS Algorithm: Output gives outer 
loadings, AVE, CR. R2, VIF → Mean, median, SD from the descriptive statistics and also 
cross-check VIF < 5 for collinearity.

Table 1

Assessment of Measurement Title 

Variables Indicators Outer loading Mean Median SD VIF

C <- Confidence

C1 0.692 5.094 6 1.762 1.448
C2 0.785 5.461 6 1.739 1.777
C3 0.848 5.104 6 1.702 2.315
C4 0.818 5.133 6 1.797 2.203
C5 0.838 5.445 6 1.544 2.294

E <- Ease of 
use

E1 0.698 3.659 4 2.055 1.41
E2 0.732 2.841 2 1.719 1.572
E3 0.894 2.878 2 1.571 3.423
E4 0.803 3.289 3 1.799 2.286
E5 0.857 2.919 3 1.531 2.581

EXP <- 
Experience

EXP1 0.86 5.104 6 1.702 2.419
EXP2 0.838 5.133 6 1.797 2.242
EXP3 0.861 5.445 6 1.544 2.439
EXP4 0.791 5.768 6 1.586 1.96
EXP5 0.773 5.122 5 1.629 1.799

H <- Help

H1 0.561 3.232 3 1.778 1.035
H2 0.848 3.339 3 1.946 2.787
H3 0.831 3.734 4 1.965 2.554
H4 0.767 3.625 4 2.051 2.172

L <- Like

L1 0.839 4.086 4 1.941 2.509
L2 0.837 3.799 4 1.981 2.505
L3 0.834 4.372 5 1.926 2.537
L4 0.82 4.828 5 1.847 2.502
L5 0.881 4.276 5 1.892 2.789
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P <- Peer

P1 0.629 3.339 3 1.946 1.264
P2 0.897 5.951 6 1.384 3.034
P3 0.92 5.844 6 1.462 3.777
P4 0.895 5.719 6 1.609 3.169

W <- 
Willingness

W1 0.718 5.768 6 1.586 1.482
W2 0.834 5.122 5 1.629 2.735
W3 0.813 5.719 6 1.609 2.373
W4 0.75 5.094 6 1.762 1.996
W5 0.856 5.461 6 1.739 3.063

Assessment of Measurement Title Refinement Guidelines
When using real datasets, researchers should carefully review the items with low or negative 
loadings and consider rewording or removing them to improve construct validity (Franke & 
Sarstedt, 2019). Indicators which are slightly below 0.70 can sometimes be used if AVE and 
composite reliability remain acceptable but required clear justification. Novice researchers 
should look after the values of VIF to detect redundancy and learn to balance theoretical 
reliability with statistical thresholds. These refinements will not only improve measurement 
quality but also helps to understand how to evaluate and refine the constructs in SEM practice. 

In Table 2, most constructs show strong reliability: Confidence (α=0.856, ρc=0.897, 
AVE=0.637), Ease of use (α=0.857, ρc=0.898, AVE=0.640), similar for Experience, Like and 
Willingness, all exceed recommended thresholds, ensuring good reliability and convergent 
validity. However, Help (α=0.750, ρc=0.878, AVE=0.578) is acceptable but weaker. Peer 
is inconsistent (α=0.473) but acceptable in (ρa=0.878, ρc=0.791 and AVE= 0.712) which 
indicates item inconsistency yet overall construct validity (Fornell & Larcker, 1981; Hair & 
Alamer, 2022). 

Reliability and Validity Checks: Results → Quality Criteria Export: Outer loadings, Alpha, 
rho_A, CR, AVE.

Table 2

Construct, Reliability and Validity

Variables Alpha rho_c rho_a AVE
Confidence 0.856 0.897 0.86 0.637
Ease of use 0.857 0.898 0.862 0.640
Experience 0.882 0.914 0.887 0.681

Help 0.75 0.843 0.734 0.578
Like 0.898 0.924 0.904 0.71
Peer 0.473 0.791 0.878 0.712

Willingness 0.854 0.896 0.858 0.633

Construct Refinements Guidelines
Beginners should review all reliability indices: Cronbach’s Alpha, CR values for rho_A and 
rho_C from Table 2 should surpass the threshold values of 0.70 and AVE value should 
exceed 0.50 which indicates the robust measure for consistency. The peer construct should 
be carefully reviewed since its low alpha may reflect some inconsistent items and can be 



19

The Lumbini Journal of Business and Economics Vol. 13, No. 2, December 2025

improved by either dropping weakly loading indicators, checking discriminant validity through 
HTMT or rephrasing survey items which may align better. Highlighting composite reliability 
and AVE alongside ensures methodological robustness and SEM best practices (Henseler et 
al., 2016; Dijkstra & Henseler, 2015). 

The majority of HTMT ratios fall within acceptable limits, reflecting good discriminant validity. 
However, there are few values exceed the recommended threshold: Confidence-Ease of use 
(0.978), Experience-Confidence (1.100), Help-Like (0.936), Peer-Willingness (1.006) and 
Confidence-Willingness (1.058) which shows potential constructs overlap, meaning some 
variables may not be sufficiently distinct. 

Discriminant Validity: HTMT → Results → Discriminant Validity → HTMT 

Table 3

Heterotrait-Monotrait (HTMT Ratio Matrix)

  Confidence Ease of 
use Experience Help Like Peer Willingness

Confidence
Ease of use 0.978
Experience 1.1 0.971

Help 0.762 0.705 0.786
Like 0.576 0.526 0.579 0.936
Peer 0.861 0.713 0.796 0.889 0.599

Willingness 1.058 0.89 0.99 0.802 0.554 1.006

HTMT Refinements Guidelines

Novice researchers should treat high HTMT values not as Failure instead as learning 
opportunity. When value exceeds 0.90, researcher should check for item redundancy or 
conceptual overlap between constructs. Bootstrapping HTMT ratios helps to make model 
more robust validity checks. Importantly, these simulated datasets like this are very useful 
learning tools as they show both acceptable and problematic validity cases, allowing beginner 
to get refine on their real dataset’s issues (Dijkstra & Henseler, 2015).

The diagonal values in Table 4 shows square roots of AVE for each construct such as 
Confidence = 0.798, Ease of use = 0.8, Willingness = 0.796). According to this, these diagonal 
values should be greater than the correlation between the constructs. Whereas, in this data 
sets some correlations are larger than the diagonal values such as Confidence-Experience 
= 0.962 > 0.798 and Willingness-Confidence = 0.905 > 0.796, which shows that there are 
issues with discriminant validity, meaning that certain constructs may be overlapping instead 
of being distinct. 

Fornell-Larcker Criterion: Results → Discriminant Validity → Fornell-Larcker
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Table 4

Fornell Larcker Criterion 

  Confidence Ease of 
use Experience Help Like Peer Willingness

Confidence 0.798

Ease of use -0.84 0.8

Experience 0.962 -0.846 0.825

Help -0.649 0.6 -0.667 0.76

Like -0.513 0.466 -0.519 0.754 0.842

Peer 0.736 -0.609 0.683 -0.696 -0.502 0.844

Willingness 0.905 -0.763 0.857 -0.67 -0.496 0.857 0.796

Fornell-Larcker Criterion Refinements Guidelines
When overlaps appear just like in Table 4, it is important not to rely on this Fornell-Larcker 
Criterion test. Instead, a better test is use it together with other measures such as HTMT ratio 
which is more reliable. If correlations remain, novice researchers should carefully examine 
the wording of the items, whether two constructs are similar and decide to remove or merge of 
construct. For the study purpose, these results are meaningful, as it helps new researcher to 
understand the limitations of Fornell- Larcker Criterion test and need for use of other various 
methods to establish discriminant validity (Henseler et al., 2014; Roemer et al., 2021; Cheung 
et al., 2023). 

In Table 5, most indicators value load highest on their intended constructs supporting 
convergent validity such as Confidence items range from 0.692 (C1) to 0.0843 (C3), Ease 
of Use from 0.698 (E1) to 0.894 (E3), Experience from 0.773 (EXP5) to 0.861 (EXP3), Like 
From 0.820 (L4) to 0.881 (L5) and Willingness from 0.718 (W1) to 0.856 (W5). However, help 
item H1 loads only 0.561 and cross loads with Ease of use only 0.612 while Peer item P1 
shows a negative loading (-0.629) both of which indicate measurement issues. It is required 
to determine that indices of an indicator should exhibit a loading of at least 0.70 towards its 
own constructs and should not contain any cross loading on any other construct while model 
measurement (Kline, 2015; Gefen et al., 2000). 

Cross-loadings: Results → Cross loadings (Each indicator should load highest on its own 
construct).

Table 5

Cross-loadings,

Indicators Confidence Ease of use Experience Help Like Peer Willingness

C1 0.692 -0.526 0.546 -0.347 -0.277 0.62 0.75

C2 0.785 -0.646 0.712 -0.624 -0.481 0.695 0.856

C3 0.848 -0.804 0.86 -0.537 -0.448 0.543 0.685

C4 0.818 -0.674 0.838 -0.486 -0.42 0.486 0.622

C5 0.838 -0.686 0.861 -0.569 -0.403 0.589 0.693

E1 -0.654 0.698 -0.649 0.489 0.536 -0.466 -0.621
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E2 -0.644 0.732 -0.646 0.408 0.3 -0.491 -0.616

E3 -0.725 0.894 -0.739 0.528 0.403 -0.524 -0.652

E4 -0.604 0.803 -0.605 0.459 0.268 -0.483 -0.531

E5 -0.718 0.857 -0.729 0.505 0.347 -0.471 -0.622

EXP1 0.848 -0.804 0.86 -0.537 -0.448 0.543 0.685

EXP2 0.818 -0.674 0.838 -0.486 -0.42 0.486 0.622

EXP3 0.838 -0.686 0.861 -0.569 -0.403 0.589 0.693

EXP4 0.695 -0.646 0.791 -0.591 -0.405 0.601 0.718

EXP5 0.755 -0.675 0.773 -0.584 -0.467 0.615 0.834

H1 -0.578 0.612 -0.579 0.561 0.202 -0.427 -0.521

H2 -0.494 0.395 -0.514 0.848 0.742 -0.629 -0.542

H3 -0.437 0.357 -0.45 0.831 0.711 -0.542 -0.482

H4 -0.354 0.345 -0.38 0.767 0.692 -0.465 -0.407

L1 -0.457 0.39 -0.455 0.679 0.839 -0.461 -0.453

L2 -0.442 0.388 -0.454 0.796 0.837 -0.512 -0.487

L3 -0.389 0.354 -0.408 0.533 0.834 -0.338 -0.33

L4 -0.368 0.345 -0.366 0.494 0.82 -0.323 -0.33

L5 -0.487 0.467 -0.486 0.643 0.881 -0.452 -0.461

P1 -0.494 0.395 -0.514 0.848 0.742 -0.629 -0.542

P2 0.65 -0.554 0.617 -0.516 -0.346 0.897 0.748

P3 0.663 -0.558 0.603 -0.559 -0.374 0.92 0.761

P4 0.66 -0.532 0.571 -0.503 -0.321 0.895 0.813

W1 0.695 -0.646 0.791 -0.591 -0.405 0.601 0.718
W2 0.755 -0.675 0.773 -0.584 -0.467 0.615 0.834

W3 0.66 -0.532 0.571 -0.503 -0.321 0.895 0.813

W4 0.692 -0.526 0.546 -0.347 -0.277 0.62 0.75

W5 0.785 -0.646 0.712 -0.624 -0.481 0.695 0.856

Cross-Loadings Refinements Guidelines
New researcher should give attention to the indicators like H1 (0.561) and P1(-0.629) item 
with weak and negative loadings that should be carefully reviewed, reword or even removed 
from the construct’s clarity. The general rule is that an indicator should cross the load above 
0.70 on its own constructs and sustainably lower on others. Cross-loadings should be 
interpreted along with other validity checks such as HTMT and Fornell-Larcker, since relying 
on single criterion may be misleading. Thus, using simulated datasets helps to access the 
problematic items for demonstrating how to detect and correct the issues before applying to 
real-world research. 
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Model Fit Assessment 
The model fit values highlight SRMR value = 0.104 (saturated) and 0.109 (estimated) which are 
slightly above the commonly accepted threshold values of (0.8-0.10) (Henseler et al., 2016). 
This result indicates that model doesn’t achieve ideal fit but remains as interpretable given 
the simulated datasets context so that novice researcher doesn’t repeat these mistakes. The 
d_ULS values (7.933 and 8.331) provide absolute measure difference between empirical and 
model-implied covariances matrices; however, benchmark for d_ULS are less standardized, 
interpretation mainly relies on values of SRMR. Overall, fit values indicate moderate model 
adequacy, acceptable for instructional demonstration but not optimal for statistical empirical 
generalization. 

Model Fit Assessment: Results → Model Fit → Check SRMR 

Model Fit Assessment Refinements Guidelines
Novice researchers should use model fit values as the diagnostic tools rather than rigid pass 
or fail test. High SRMR values can generate signal issues such as model complexity, item 
redundancy or misspecification. Beginners should practice comparing saturated vs estimated 
models, test simplified models, and report SRMR value alongside with other criteria such as 
reliability, validity to provide a balanced evaluation. In this simulated datasets, slightly poor 
fit can be teaching opportunity which ultimately helps novice to understand the important of 
refining measurements before applying SEM in real-world research datasets. 

In Figure 2, model shows that confidence is strong mediator with the value of R2 = 0.9420 
which explains most of the variation in Willingness R2 = 0.8140. Confidence has a very 
strong direct effect on Willingness (β = 0.878, p < 0.001), confirming its major central role. 
Among independent variable, Help and Peer contribute positively and Ease of use and Like 
shows negative influences. The moderating effect of experience on other paths are minimal 
and insignificant in statistical terms, demonstrating very little interaction strength, although 
experience explains an enormous amount of variance (R2 = 0.814).

Bootstrapping (Significance testing): Calculate → Bootstrapping → Settings: 5000 or 10000 
subsamples, Two-tailed test → Output: Path coefficients, t-values, p-values, CI. 

Structural Equation Model
Novie researcher should not only report significant paths but also learn from non-significant 
paths too, as they highlight model complexity. Visualizing the model with clear value of R2 
and β coefficient helps to gain insights about mediation and moderation. Researcher should 
also state both positive and negative effects, instead of emphasizing theoretical justifications 
over significance chasing. Although the model shows strong explanatory power, refinement 
is needed for model robustness. Non-significant moderators indicate measuring the larger 
sample size or alternative moderation approaches (Henseler & Chin, 2010). Negative 
paths such as Ease of use should be revisited for possible measurements or theoretical 
misalignments. Reporting indirect effects along with HTMT would strengthen methodological 
rigor. Thus, improving all these by researcher can enhance the pedagogical as well as 
technical value in SmartPLS modeling (Franke & Sarstedt, 2019). 

The structural model was assessed with the help of bootstrapping in SmartPLS, which provides 
non-parametric estimates of path significance performed with 10000 subsamples which 
examined the hypothesis. Results from Table 6 highlights that confidence strongly predicts 
willingness, confirming its central mediating role. Similarly, experience, peer, help significantly 
enhance confidence. In contrast, Ease of use showed a small negative effect (β = –0.082, p 
= 0.002), while Like (β = –0.039, p = 0.133) and all interaction terms with Experience were 
statistically insignificant. These findings suggest how bootstrapping captures both significant 
and non-significant relationships which helps to provide novice researcher a practical guide 
to interpret such results (Henseler & Chin, 2010; Nitzl et al., 2016). 
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Figure 2 

Structural Equation Model Refinements Guidelines

Table 6

Hypotheses Testing Using Bootstrapping

                                               Confidence Interval

Hypotheses  
Beta(β) 

Sample 
mean 
(M)

Standard 
deviation 
(STDEV)

2.50% 97.50% T-stat P 
values Decision

H1 Confidence 
-> Willingness 

(Mediator-DV) 0.905 0.905 0.012 0.879 0.926 76.13 0 Accepted

H2 Ease of use -> 
Confidence (IV- 

Mediator) -0.082 -0.08 0.026 0.759 0.875 3.152 0.002 Accepted

H3 Experience 
-> Confidence 

(Moderator main 
effect-mediator)

0.816 0.817 0.03 0.154 0.253 27.412 0 Accepted
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H4 Experience 
x Ease of use 
-> Confidence 
(Interaction)

0.008 0.007 0.024 0.042 0.15 0.325 0.745 Rejected

H5 Experience x 
Help -> Confidence 

(Interaction)
-0.041 -0.044 0.032 0.004 0.114 1.29 0.197 Rejected

H6 Experience x 
Like -> Confidence 

(Interaction)
0.054 0.057 0.028 -0.042 0.053 1.958 0.05 Rejected

H7 Experience x 
Peer -> Confidence 

(Interaction)
0.016 0.014 0.019 -0.024 0.05 0.853 0.394 Rejected

H8 Help -> 
Confidence (IV-

Mediator)
0.091 0.094 0.028 -0.108 0.016 3.272 0.001 Accepted

H9 Like -> 
Confidence (IV-

Mediator)
-0.039 -0.041 0.026 -0.092 0.01 1.502 0.133 Rejected

H10 Peer -> 
Confidence (IV-

Mediator) 0.197 0.2 0.025 -0.131 -0.029 7.757 0 Accepted

Note. Dependent variable (DV)= Willingness; Independent Variables (IVs)= Ease of Use, Help, Like, 
Peer; Mediator= Confidence; Moderator= Experience.

Hypothesis Refinements Suggestions
Bootstrapping values always include t-values, p-values and Confidence Interval (C.I.). 
Researcher should practice why some hypotheses are rejected, since these non-significant 
paths are valuable source of teaching. For robust methodological accuracy, as this is 
simulated datasets used for pedagogy efficiency, researcher should report indirect mediation 
effects with bias-corrected bootstrap confidence intervals, refine moderation tests either by 
increasing sample size or visualizing slopes and aligning the results by revisiting items wording 
or multicollinearity checks. Thus, this will increase pedagogical efficiency by strengthening 
technical accuracy. 

Table 7 shows that Confidence (71.091, 0.878) is the major driver of Willingness, followed 
by Experience (72.012, 0.555). However, Help (40.59, 0.116) has low performance but 
some positive potential, while peer support (87.87, 0.052) is strong but low in importance. 
In contrast, Ease of use and Like shows negative or weak importance, meaning they do not 
increase Willingness. 

Calculation of IPMA: Calculate → IPMA → Select target Constructs → Results: Performance, 
Importance → Compute mean values to draw crosshairs.



25

The Lumbini Journal of Business and Economics Vol. 13, No. 2, December 2025

Table 7

Importance Performance MAP Analysis

 Variables LV Performance Importance

Confidence 71.091 0.878

Ease of use 34.204 -0.063

Experience 72.012 0.555

Help 40.588 0.116

Like 54.398 -0.176

Peer 87.866 0.052

Mean 60.0265 0.227

Importance Performance MAP Analysis Refinements Suggestions
Novice researcher should focus on building confidence through guided practice and build their 
experience through step-by-step simulations. Improve variable Help with better scaffolding 
and support, while Peer support as secondary. Avoid overemphasizing Ease of use and Like, 
since they do not positively drive learning outcomes.  

The analysis in Figure 3 using performance (60.03) and importance (0.23) as divider lines 
between graph, shows Confidence and Experience as high-priority strengths, while Help 
requires refinement. However, Peer is effective, but it doesn’t show as a key driver. Ease of 
use and Like are the lowest priority. 

Figure 3

Importance-Performance MAP

 

Importance Performance MAP Refinements Suggestions
The MAP from Figure 3 shows that Confidence and Experience are the key drivers giving 
learners a clear image of how strong constructs should appear. Similarly, Help has weak 
performance but some importance, which is useful for showing need to improve support and 
scaffolding. Peer indicates even though there are strong scores which are not always central, 
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while Ease and Like highlights how constructs can be misleading. This result helps beginner 
learn to identify the strength, weakness and mistakes in SEM before applying it to the real-
world research datasets. 
V.	 Conclusion and Implications
This study was undertaken to respond a methodological gap identified in the literature 
although the widespread utilization of PLS-SEM, novice researchers continue to lack a 
complete and accessible roadmap which connects theory, data and interpretations through 
SmartPLS. Prior studies often concentrated on either measurement or structural modes or 
overlooked the fundamental checks of reliability and discriminant validity. Such gaps left a 
practical divide between the theoretical foundations of SEM and its applied use in research 
and pedagogy efficiency. Thus, this research provides roadmap for beginner to apply PLS-
SEM using SmartPLS. Unlike empirical research aimed at generalization, the analysis was 
based on simulation datasets designed to demonstrate methodological workflows and 
highlights common mistakes that researchers’ make. 

Outlining on Technology Acceptance Model (TAM), Social Cognitive Theory (SCT), and Theory 
of Planned Behaviour (TPB), theoretical foundation strengthens the research’s objective. 
TAM shows how transparent and structured processes creates low barriers to adapt the new 
tools, indicating even error-prone practice can increase learners’ openness to technology. 
SCT also indicates the role of practice and feedback in building self-efficacy, working through 
the mistakes and provides students with confidence to manage complex models. Likewise, 
TPB also highlights that positive attitudes and supportive guidelines helps to lead learning 
intentions through the help of errors and the fast map fosters positive attitudes and reduces 
resistances.   

The implication of this study is twofold: theoretically, this roadmap helps to strengthen the 
bridge between SEM’s conceptual underpinnings and applied practice. For practice, it 
provides educators and early-career researchers with a step-by-step guide which transforms 
methodological pitfalls into opportunities for learning. SmartPLS is not just a statistical tool, 
but also a pedagogical framework which strengthens both methodological robustness and 
teaching of applied research methods. Overall, this research findings are not statistically 
generalizable; however, pedagogically significant. 
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